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NHDES Public Information Guidelines 
Consistency in publications helps the public and our stakeholders recognize and have confidence in the 
content we are providing. Formerly known as the Publication Guide, this set of guidelines covers all types of 
Public Information being issued by NHDES. 

Please see the NHDES Social Media Policy for information on using platforms such as Twitter, Facebook, 
YouTube and blogs to spread awareness of your program. 

This document is owned and maintained by the NHDES Assistant Public Information Officer. 
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1 NHDES Publication Style Guide 
This chapter covers the accepted styles that can be used for publications, letters and emails. A publication is 
any type of outreach material, such as reports, presentations, webpages, brochures, BMPs, banner stands, 
program logos, etc. Publications must be approved through the Public Information and Communications Unit 
(PIC). The review and approval process exists to make sure that all NHDES communications look like they came 
from the same agency, are professional and follow federal standards for accessibility and civil rights. 

While emails and letters are not reviewed by PIC, they must still adhere to this Style Guide and follow Section 
508 and Nondiscrimination standards.  

Templates/Formatting Guides are available for: 

• Email Signatures 
• Email Confidentiality Statements 
• Fact Sheets 
• Forms 
• PowerPoint Presentations 
• Reports 

Please review the entire Style Guide. Questions can be directed to the Assistant Public Information Officer. 

1.1 Publication and Review Requirements 
Publication review begins with program/bureau review. The Web Tech team will supply a second review to 
make sure that all sections of a document are present per this guide (for example, report or guidance 
document cover/title page, table of contents, image alt tags, form requirements).  

1.1.1 Public Information and Communications Review 

PIC shall review all publications prior to having them printed or posted on the web. 

This review is for quality control and comments are primarily restricted to overall readability, general 
formatting, professional appearance and Section 508 compliance. It is not a technical review. Please 
build time into your schedule for this review to avoid any delays or stress in completing publications.  

NOTE: it is particularly important that reports to federal partners, such as EPA, or the legislature be 
reviewed prior to being sent out. 

Documents must be provided in their original formats: Word, PowerPoint, Excel, etc. Edits, if any, will be 
returned with Track Changes.  

Internal and Peer Reviews: please follow your program’s unique protocol for internal reviews prior to PIC 
review.  

1.1.2 Printing Publications 

If you plan to use the NHDES Revolving Publications Fund for printing, publications must be pre-
approved by PIC for funding. Contact Graphic Services for cost and timeframe quotes. 

Depending on the design of your publication and where it will be used, publications can be created in 
Word. Fact sheets must be in Word. Newsletters and documents with several photos ideally should be 
created in InDesign, especially if the job will be going to a commercial printer. Avoid using PowerPoint 
or Publisher to make print documents. PowerPoint is a program solely for making electronic 
presentations and does not convert well to print media. PIC can help with layout and design.  
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If you are using a commercial printer to have your project printed, please know in advance the print 
specifications they require before sending your job to them. Costly mistakes can be avoided if there is 
clear understanding of the process beforehand. 

By statute, all state publications are to be printed on recycled stock. Any document sent to Graphic 
Services will automatically be printed on recycled stock. 

1.1.3 Vendor-created Content 

If your program will be working with an outside vendor to create a report or outreach materials, such as 
webpages, web apps, etc., it is important that PIC be involved at the beginning of the project. For 
example, PIC can provide feedback on what website limitations may exist or let the vendor know in 
advance that forms must be created using the New Hampshire Online Forms system (exception: forms 
can be created outside of New Hampshire Online Forms if the form will feed into a database managed by 
the Vendor). 

1.2 NHDES vs. DES vs. NH DES vs. The NHDES 
How you address the name of the agency in all publications should be reflective of the logos: either fully 
spelled out – New Hampshire Department of Environmental Services – or the acronym – NHDES. Reference to 
NHDES as “the department” should be limited and always in lower case. There should never be a space or a 
dash between NH and DES. The acronym “NHDES” is used in the abbreviated logo. The agency should never be 
referred to as “the NHDES” – when creating an acronym, the “the” is almost always dropped. Examples: EPA, 
NHDOT, NHFG, PIC, etc. 

1.3 Logo Use Policy 
The logo use policy is part of the Employee Manual.  

The NHDES logo may not be altered in any way, except to make larger or smaller. There are two versions of the 
logo: one with the agency’s name spelled out and one with the acronym. Official logos can be provided by PIC. 
Do not copy logos from the NHDES webpage. Any document or presentation created by and for NHDES must 
include a NHDES logo. 

The full logo should always be used, with the following exceptions: 

• The department name is already spelled out, such as with the NHDES letterhead. 
• The instance will be small, making the words difficult to read. 

The formal NHDES logos are three-color and one-color. The colors of the three-color logo may be screened but 
may not be altered. If a print job is being done in all one color, the one-color logo may match, even if it is a 
non-standard color (such as red). 

For printers requiring color codes:  

• Blue: Hexadecimal – 353895; PMS – Pantone 661 C  
• Green: Hexadecimal – 316735; PMS – Pantone 7743 C 

A minimum open space of approximately the width of the tree must be kept around the logo. 
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1.3.1 Program Logo Development 

A program may develop its own logo, but that logo must be approved by PIC. PIC can provide logo 
development services. 

1.4 NHDES Letterhead 
The official NHDES letterhead and letter template can be found on the S Drive. Legislative letters of testimony 
are governed by NHDES standard operating procedure (SOP) 111 – Legislative Testimony Letters.  

1.5 Standard Styles 
PIC uses the Associated Press Stylebook and the Chicago Style Manual for proofing and editing NHDES 
publications, including webpages. These stylebooks are sources used by American journalists, authors and 
corporate writers. Either Harvard or APA styles should be used when creating references. 

1.5.1 Font 

The standard for all outreach materials, presentations and written correspondence is Calibri 11. Please 
note that SOP 111 – Legislative Testimony Letters calls for Calibri 13. 

One or two “accent” fonts, such as Cambria, can be used in a publication but they should be used 
sparingly and at a larger point size. An example of this would be the publication title or section headings.  

It is important to consider your audience when choosing accent fonts. For example, a handwriting or 
chalkboard font may be appropriate for a publication targeted towards students and teachers but would 
not be appropriate in a technical report or even general correspondence. 
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1.5.2 Paragraphs 

All written correspondence should use block paragraphs, such as in this document. Use paragraph 
spacing, rather than an extra paragraph break to set the space between paragraphs. 

Paragraph spacing should be set to 8pt After with a line spacing of Multiple 1.08. 

Access Paragraph spacing using the expand arrow in the Paragraph section of the Home tab.  

 

You can also access the “After” spacing quickly from the Layout tab. 

 

1.5.3 Justification 

Body text of a publication should be left-justified. Center or right justification can be used to call out 
portions of text but the use should be kept to a minimum. Never use full justification (see Section 508 – 
Typography: Justification). 
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1.5.4 Tabs, Breaks and Columns 

Use Tab Stops if you need to set text in a line apart, such as in a form. Tab settings are available from the 
Paragraph Styles window. Do NOT click Tab multiple times to create the space (see Section 508 – 
Typography: Spacing). 

 

Use Page Breaks if you need to push text to the next page. Click the Insert tab and then Page Break. Do 
NOT click Enter multiple times to move text to the next page. 

 

Use Section Breaks if you need to create columns on the same page with regular text, or if you need to 
change the page numbering. Click the Layout tab and select Breaks. 

 

Use Columns to set text apart, such as in a “callout” box. Do NOT use text boxes as they cause 
accessibility issues. 

1.5.5 Emphasis 

Only use boldface or italics when emphasis is needed. Avoid using ALL CAPS, as that comes across as 
shouting. (More information under Section 508 – Typography: Emphasis) 

1.5.6 Acronyms 

Use acronyms sparingly, if possible – do not let your document become an alphabet soup. If many 
abbreviations and acronyms cannot be avoided, consider including a list of the used acronyms. When 
defining an acronym or abbreviation, do NOT use both parentheses and quotation marks.  

Correct: the Department of Environmental Services (NHDES). [Note: legal writing contradicts this rule.] 
Incorrect: the Department of Environmental Services (“NHDES”). 

TIP: Treat acronyms as though they are spelled out when using them in a sentence. For instance, the M 
in ATM stands for “machine” so saying ATM machine is redundant. 

EXAMPLES: This is a NHDES document; PFAS are chemical compounds. 
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State names should be spelled out in text and only be abbreviated when they follow the name of a city, 
town or county. Use Postal Service abbreviations for the states. 

Correct: In many parts of the country, including New Hampshire and Maine, this is a problem.  
Incorrect: In many parts of the country, including NH and ME, this is a problem.  

1.5.7 Lists 

Bullets should be used to introduce individual sections of a list. Capitalize the first word following the 
bullet. Use periods, not semicolons, at the end of each section, even if it is not a complete sentence. A 
bulleted list is considered inclusive so “and” is not needed before the last bullet. 

Example: Jones gave the following reasons: 

• He never ordered the package. 
• If he did, it didn’t come. 
• If it did, he sent it back. 

1.5.8 Links 

Hyperlinks (URLs) included in publications should be colored and underlined. Use the standard hyperlink 
blue or other contrasting color: www.des.nh.gov. Use descriptive links unless it is the “domain” or 
homepage of a website (for example, www.epa.gov, www.des.gov) (see Section 508 – Web Addresses 
and Descriptive Links). 

1.5.9 Punctuation 

1.5.9.1 Periods 

The rule in the publishing world is a single space between sentences (see Section 508 – 
Typography: Spacing). 

1.5.9.2 Commas 

Use commas to separate elements in a series but do not put a comma (also known as an Oxford 
comma) before the conjunction in a simple series: The flag is red, white and blue. He would 
nominate Tom, Dick or Harry.  

DO use a comma before the concluding conjunction in a complex series of phrases: The main 
points to consider are whether the athletes are skillful enough to compete, whether they have the 
stamina to endure the training, and whether they have the proper mental attitude.  

1.5.9.3 Semicolons 

Use semicolons to separate elements of a series when individual segments contain material that 
also must be set off by commas: He leaves a son, John Smith of Chicago; three daughters, Jane 
Smith of Wichita, KS, Mary Smith of Denver, and Susan, wife of William Kingsbury of Boston; and a 
sister, Martha, wife of Robert Warren of Omaha, NE. 

Avoid using semicolons to separate portions of a sentence. Create two sentences instead. This 
will keep your sentences shorter and more understandable. 

1.5.9.4 Quotation Marks 

Commas and periods always go inside “quotation marks.” Question marks and exclamation points 
go outside “quotation marks”! 

 

http://www.des.nh.gov/
http://www.epa.gov/
http://www.des.gov/
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1.5.10 Grammar 

Below is a list of the most common grammar questions encountered in NHDES publications. 

1.5.10.1 Numbers 

In general, spell out whole numbers below 10, use numbers for 10 and above, even in the same 
sentence. Example: They had a fleet of 10 vans and two pick-up trucks. Use numbers when 
decimals are included. Example: The file size is 2.3 megabytes. 

When a sentence begins with a number, it is spelled out. 

Do not spell out and use numbers when referring to the same number. 

Correct: There was a setback of 25 feet.  
Incorrect: There was a setback of twenty-five (25) feet. 

1.5.10.2 Possessives 

When referring to a decade, DO NOT use an apostrophe unless the decade is in possession of 
something:  

Correct: in the 1980s.  
Incorrect: in the 1980’s. 

The possessive form of NHDES is NHDES’. 

1.5.10.3 Parentheses 

Use parentheses sparingly. The temptation to use parentheses is a clue that a sentence is 
becoming too complicated. If a sentence must have incidental material, it may be more effective 
to use commas or m-dashes (–). Avoid using two dashes together (--).  

Keyboard shortcut: hold down the Alt key and type 0150 to create an m-dash in most 
applications. 

1.5.10.4 State and Federal 

Lowercase when used as an adjective to distinguish from county, city, town or each other. 
Capitalized when used as a formal name: Federal Trade Commission; or in reference to the 
governing body: “Pat and the City agree…” 

1.5.10.5 That vs Which 

That is the preferred pronoun to introduce “essential clauses” that refer to an inanimate object. 
Which is the only acceptable pronoun to introduce a “nonessential clause” that refers to an 
inanimate object, and it is always preceded by a comma.  

An essential clause is a word or group of words critical to the reader’s understanding of what the 
author had in mind.  

A nonessential clause provides more information about something. Although the information may 
be helpful to the reader’s comprehension, the reader would not be misled if the information were 
not there. 

EXAMPLES: 
Maria gave Carlos a study guide for material that was going to be on the test. 
Carlos gave Maria notes from chapters three through seven, which were going to be on the test.  
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1.5.10.6 Who vs Whom 

When an essential or nonessential clause refers to a human being, it should be introduced by who 
or whom. Do not use commas if the clause is essential to the meaning; use them if it is not.  

TIP: Use the “he/him” method. 

EXAMPLES: 
Who/Whom wrote the letter? 
He wrote the letter. Therefore, who is correct. 

Who/Whom should I call? 
I should call him. Therefore, whom is correct. 

1.5.10.7 i.e. vs e.g. 

i.e. and e.g. should be used sparingly to maintain a high readability score. When used, they 
should always be followed by a comma. They should not be italicized.  

Rather than use i.e., consider using “for instance.” Use “for example” in place of e.g. 

1.5.10.8 Common Spelling 

Below is a list of commonly encountered misspellings or inconsistencies in NHDES publications. 

Email – no hyphen 
Online – no hyphen 
Groundwater – all one word 
Homepage – all one word 
Stormwater – all one word 
Webpage – all one word 
Website – all one word 

1.6 Email Formatting 
It is important that emails sent from NHDES accounts appear professional and be accessible. Please use the 
following guidance when setting your email defaults. 

1.6.1 Font 

The standard font for NHDES is Calibri 11. DO NOT use handwriting fonts, such as Comic Sans – they do 
not look professional and can cause readability issues. 

1.6.2 Colored and Textured Backgrounds 

DO NOT use any type of colored or textured background in your emails (see Section 508 – Background 
Images). 

1.6.3 Signature 

It is important for email signature blocks to look professional and provide information in a clear, succinct 
way. Some programs, bureaus or units may need to include additional information, such as 
confidentiality statements (see next section for example statements). Below is a basic signature 
template that can be used. To normalize gender differences and encourage inclusion, pronouns can be 
added after or below your name. Examples: she/her, he/him, they/them.  

Avoid using pipes (|) to make your signature horizontal. Long signature lines do not translate well to 
mobile devices, as the lines often break in awkward places. 
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Note: if you use images in your signature block, such as the NHDES logo, social media icons or the leaf 
icon seen in the template, alt text is needed (see Section 508). 

TIP: link your phone number for mobile devices! Add the Link using this format: tel:+16032715555. 

Your Name (pronouns placement option) 
(pronouns placement option) 
Your Title 
Your Division and/or Bureau 
New Hampshire Department of Environmental Services 
29 Hazen Drive, PO Box 95 
Concord, NH 03302-0095 
(603) 271-5555 

des.nh.gov 
twitter.com/NHDES 
facebook.com/NHEnvironmentalServices/ 

Please consider the environment before printing this email.  

1.6.4 Confidentiality Statements 

Some programs, bureaus or units may need to incorporate confidentiality statements into email 
signatures. One common error is to misspell “email.” There is no dash in the word email. Here are two 
examples currently used within NHDES that can be copied into a signature block. 

Example 1: 

This email and any associated files are intended solely and exclusively for the use of addressee(s), and 
may be privileged, confidential or otherwise protected by law. 

Example 2: 

Statement of Confidentiality: This email and any files transmitted with it are confidential and intended 
solely for the use of the individual or entity to which they are addressed. This communication may 
contain material protected by law or regulation. If you are not the intended recipient or the person 
responsible for delivering the email to the intended recipient, be advised that you have received this 
email in error and that any use, dissemination, forwarding, printing or copying of this email is strictly 
prohibited. If you believe you have received this email in error, please notify me at the New Hampshire 
Department of Environmental Services: (603) 271-5555. 

1.7 Document Formatting 

1.7.1 Background 

The following is a list of attributes that must be considered when creating any publication, such as a 
report or guidance document. PIC is available to help with layout and design. A report template is 
available in the Publication-Guidelines\templates folder on the S-Drive. 

1.7.1.1 Document Number 

All NHDES-authored or contracted documents must be inventoried. All reports, BMPs, fact sheets, 
etc. are assigned a document number during PIC review process. While brochures and one-page 
fliers do not receive document numbers, they still need to be catalogued and added to the 
publication inventory.  

tel:+16032715555
http://des.nh.gov/
https://twitter.com/nhdes
https://www.facebook.com/NHEnvironmentalServices/


Public Information Guidelines 13 October 21, 2022 

1.7.1.2 Cover Page 

Multi-page documents, such as reports and BMPs, should have covers, which will include the title 
of the document and the NHDES logo. The placement of these items, the colors used and the 
inclusion of images or other information on the cover may vary from document to document. In 
general, every effort should be made to present an attractive, professional-looking cover. PIC can 
provide suggestions or design assistance. 

1.7.1.3 Title Page 

Every multi-page document, such as reports and BMPs, should have a title page that includes the 
following items: 

• The document number must appear on the upper right-hand corner of the page. 
• Title of the document with the same title as it appears on the cover. 
• “Prepared by ...” (insert the names of the preparer with division). 
• Names of the Commissioner, Assistant Commissioner and/or Division Director. 
• Publication Date. 
• NHDES logo (please see logo use policy). 
• Department address, phone number and web address.  

Example Address 
New Hampshire Department of Environmental Services 
PO Box 95, Concord, NH 03302-0095 
des.nh.gov  |  (603) 271-3503  

1.7.1.4 Acknowledgement Page 

Optional. If included, the acknowledgment(s) should be worded in a discreet, professional 
manner. 

1.7.1.5 Table of Contents (TOC) 

Large documents with varying sections must have a complete table of contents that lists each 
section and subsection. The TOC must be linked and built using Styles to comply with Section 508 
(see Section 508 – Typography: Heading Styles). A separate list of figures, tables and/or charts can 
be included, when appropriate.  

1.7.1.6 Footnotes, Endnotes and References 

Any footnotes, endnotes or references must be added using the References tab. Endnotes and 
references should appear at the end of the report and should use the Harvard or APA style. 

1.7.1.7 Pagination 

Page one should start on a right-hand page (even if there is no intention to print), and every page, 
including blank pages, should be numbered and/or accounted for. 

1.7.2 Fact Sheets 

Any fact sheet created after 2007 will be in the PIC fact sheets folder. Please refer to this folder to find 
the version of your fact sheet that is currently on the website.  

Fact sheets should be shorter, concise documents. Anything significantly longer than two pages may be 
better suited as a guidance document. 

New and updated fact sheets must be sent to PIC as Word documents.  

https://www.des.nh.gov/
tel:+16032713503
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1.7.2.1 Formatting 

All NHDES fact sheets shall have a number, assigned by PIC, set flush to the left margin, and the 
year of the most current edition, flush right, on one line under the mast head. This line is set 2-
1/2” down from the top edge of the paper. 

All fact sheets must have a descriptive title, centered, typed in upper and lower case, 14-16 point 
in size, depending on the length of the title; for example, short titles may need a larger point size 
for emphasis.  

Apart from “NHDES,” acronyms generally should not be used in titles unless there are spacing 
issues. 

All fact sheets should be set in Calibri 11 pt font. 

Paragraph headers must use the Styles from the Word Home tab for accessibility. 

1.7.2.2 Program Review 

Fact sheets must be critically reviewed every two years to ensure that all information and 
references are up-to-date. For example: Do you have the most current RSA/chapter referenced? 
If you’ve referenced another agency’s or bureau’s publication, is that publication still available or 
has the title changed? Are web addresses/links current? Consider adding a line at the very end of 
the document stating when the information is valid as of or until, if appropriate. While content 
may still be relevant and not require updating after two years, it is important to keep the dates on 
fact sheets recent for public confidence. 

1.7.2.3 Printing 

Only PIC has permission to publish large quantities of hard copies with the color masthead. The 
office will be happy to make as many copies as you need for conferences, workshops or mailings. 
Please give the Public Information Center advanced notice of large print jobs. For example, 200 
copies of a fact sheet takes about five business days to complete. Larger print jobs may need to 
be sent to Graphic Services and could take up to two weeks to complete. 

1.7.3 Presentations 
A template PowerPoint slide deck is available in the Publication-Guidelines\templates folder on S Drive. 
When creating a presentation, it is important to remember that all publications are subject to posting on 
the NHDES website. NEVER use copyrighted material or images without express permission. 

The template slide deck includes the following branding standards that must be present in all NHDES 
presentations. 

• NHDES logo on title page. 
• Slide numbers. 
• Section headings. 
• A contact slide. 

Other considerations: 

• All presentations must conform to Section 508. 
o NOTE: A transcript of the presentation must be available. If you script your presentation, 

add your script text to the appropriate slides in the presenter’s notes and make them 
available when saving as a PDF. 
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1.7.3.1 Copyright- and Attribution-Free Images 
NEVER use just any image you find from a browser search. If you find an image marked with a 
Creative Commons (CC) copyright, do NOT assume it is ok to use. Many CC images still require 
attribution – where you must include the name or website of the image author. 

All NHDES staff images taken for work purposes or submitted to NHDES photo contests are 
copyright- and attribution-free. All images submitted to #ThisIsNH are available but should 
provide attribution (although it is not required) – full resolution versions of the images must be 
acquired through PIC. PIC created an image library that contains staff-submitted images. This 
folder also has a “stock” image folder with copyright- and attribution-free images. 

A list of websites where you can find copyright- and attribution-free images, graphics and videos 
is on the intranet.  

https://arcg.is/mPmfm
file://granite.nhroot.int/shared/des/CO-PIP/Photos-and-Graphics/image-library
http://desintranet/wp-content/uploads/copyright-free-images.pdf
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2 Section 508 of the Rehabilitation Act and WCAG 

2.1 Background 
Section 508 of the Rehabilitation Act, commonly referred to as “ADA” (Americans with Disabilities Act) covers 
accessibility in information and communication technology. While ADA Title VI covers Nondiscrimination, the 
standards referenced here are listed under Section 508 of the Rehabilitation Act: information and 
communication technology, which includes reference to the website content accessibility guidelines (WCAG). 
ADA and the Rehabilitation Act are Civil Rights acts. 

Because Section 508 is federal legislation, all federal government agencies, their contractors, and the 
organizations that work with them are legally required to comply with it. Section 508 also applies to any 
government agency that receives federal funding at a state, county or municipality level. 

The State of New Hampshire Accessibility Policy states, “New Hampshire State Government is 
committed to making all electronic resources accessible to all users. A key component of the 
state's e-Government Strategy and Architecture is "universal access". This requires all 
agencies to provide universally accessible websites that enable persons with disabilities to 
access them.” 

Section 508 (WCAG 2.2 – as of December 2021, WCAG 3.0 is in DRAFT) includes all publications and 
communication technology – apps, documents, forms, presentations, websites, hardware, etc. When 
publications are made accessible to people with disabilities, they become easier to use for everyone. There are 
many tools used to make documents accessible that, when used properly, make creating the documents easier 
as well. As a government entity, it is important that we lead by example and not discriminate against people 
with disabilities. For more information about nondiscrimination, see the NHDES Title VI Nondiscrimination and 
Environmental Justice intranet page. 

It is common for people to think of “disability” as a physical impairment. However, a disability is “a physical or 
mental impairment that substantially limits one or more major life activity.” Not all disabilities can be seen.  

Document accessibility is not just for the blind community – we need to consider any disability that may have a 
perception or cognition component, such as colorblindness, low vision, dyslexia, cognitive delay, etc. 

Most of the NHDES Style Guidelines are based on compliance with Section 508. 

2.1.1 Resources 

The information below will tell you why and how to use accessibility guidelines. Use the NHDES Section 
508 and WCAG Publication Checklist to assist you in making your documents accessible. Additional, 
document type-specific checklists can be found on the Social Security Accessibility Resources webpage. 

• Section508.gov – Create Accessible Documents 
• Section 508.gov – Accessibility Training Videos 
• WebAIM Color Contrast Checker 
• W3.org Web Content Accessibility Guidelines 
• WAVE – web accessibility evaluation tool 
• Microsoft Accessibility Tools 

2.2 File Naming 
File names cannot have spaces. Use dashes to separate words. Do not use underscores or other special 
characters in file names. Files names should be fewer than 30 characters and descriptive of the file content. 

https://www.w3.org/TR/wcag-3.0/
https://www.nh.gov/policy/accessibility.htm
http://desintranet/?page_id=17299
http://desintranet/?page_id=17299
http://desintranet/wp-content/uploads/508-wcag-checklist.docx
http://desintranet/wp-content/uploads/508-wcag-checklist.docx
https://www.ssa.gov/accessibility/developer_resources.html
https://www.section508.gov/create/documents/
https://www.section508.gov/training-home/#Trainingvideos
https://webaim.org/resources/contrastchecker/
https://www.w3.org/TR/WCAG21/
https://wave.webaim.org/
https://www.microsoft.com/en-us/accessibility/
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They must also be in the most recent available version of the software being used. For example, .docx instead 
of .doc. This also helps with search engine optimization and prevents accidental breaking of URLs. 

2.3 File Information 
You must include a title and tags in the File Info section of documents. In most programs, this can be found by 
clicking File > Info –or– File > File Information. In M365 apps, click the File Tab and then click Info. 

 

On the right side of the screen, you will see a Properties Section.  

 

2.4 Track Changes 
Be sure to accept or reject all track changes and remove any comments before publishing. 

2.5 Non-text Alternatives: Image Descriptions, Audio/Video Captioning 

2.5.1 Background 

Image descriptions (or alternative text), commonly called “alt text,” are used by screen readers to 
provide full access to documents and webpages. People with slow internet access may also turn images 
off on websites to increase page loading. It is important to describe how the image you selected fits into 
the story you are telling. 

If image captions are being used, the alt text should be complimentary and not repetitive. 

Audio and video files must have transcripts and/or captioning for the deaf and hard of hearing. Videos 
must also provide a descriptive text alternative for non-text content. 

2.5.2 Background Images 

Avoid using background images below text. Typically, textures or variations in an image will cause 
contrast issues with text. Background images or textures can also be distracting.  

Background images, colors or textures should never be used in email correspondence. 
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2.5.3 Headers, Footers and Watermarks 

Assistive technology will not automatically read information in headers, footers and watermarks so any 
vital information contained in them must be duplicated in body text. 

2.5.4 Image Placement 

Images need to be “inline” with the text. Never put images into a text box.  

2.5.5 Adding or Editing Alt Text 

Adding alt text to an image can be done a couple ways. When using M365 tools, such as Word, a grey 
box will appear at the bottom of the image. Word will automatically generate alt text but it usually 
needs to be edited. Remember, alt text should be complimentary to the story you are trying to tell. Click 
in the grey box to open the Alt Text editor pane. If the grey box does not appear, you can right-click the 
image and select “Edit Alt Text…” 

 

 

In the Alt Text editing pane, you have the choice to have Word generate a description. This should be 
used sparingly but it can be helpful if you are stuck coming up with ideas of how to write alt text. 
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2.5.5.1 Decorative Images and Figures 

If an image is used only for decoration and has no content value, it should be marked as 
decorative in the Alt Text editor (see bottom of screenshot above). 

Shapes, such as lines used in forms or as column separators, should also be marked as decorative. 

2.5.6 Creating Appropriate Alt Text 

Think about why you are including an image. What do you want a sighted person to take away? Alt text 
should be concise and descriptive. It should not be repetitive of the body text or a caption. 

All text in an image should be represented in the alt text. Avoid using images of text as much as possible. 

Do NOT start alt text with “image of.” Screen readers will cue the user by saying “image” or “figure” 
before reading the alt text. 

2.5.6.1 Charts and Graphs 

Text on charts can be summarized but you should include the titles for the axes and a description 
of the reason for using the data visualization. 

2.5.7 Images in Tutorials 

If you are creating a tutorial with screenshots, you might not need to use alt text. Alt text should never 
be duplicative of the paragraph text so if you describe the action a user needs to take in paragraph text 
and then also include an image, you do not need alt text. If you use an image IN PLACE OF paragraph 
text, you do need to include alt text. 

Example: In this example, the first two images require alt text because they are being used in place of 
text. The third image does not require alt text but should be marked as decorative. 

Go to https://sson.nh.gov/ and sign into NHFirst. 

1.  Once signed in click on the  

2.  Click on  

3. Input 17163 into the Job ID field and search 

  

NOTE: If you are creating a tutorial on the visual identification of something, such as cyanobacteria, it is 
acceptable to add an introduction slide explaining that. Images could then be marked as decorative. 

2.5.8 Time-based Media 

Video and audio files, as well as live and pre-recorded slide presentations, are considered time-based 
media. A descriptive text alternative must be provided. 

2.5.8.1 Transcriptions and/or Captions 

Recorded videos created for social media or meetings must have captions or transcriptions. 
Videos without speech must also provide a descriptive text alternative for non-text content and a 
text-based description of the reason for the video. 

https://sson.nh.gov/
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2.5.8.2 Audio Recordings 

Audio-only recordings must have a transcript. Teams automatically provides transcription; 
however, the transcription will need to be reviewed/edited for speech-to-text accuracy. 

2.6 Typography 

2.6.1 Fonts for Low Vision and Neurodiversity 

A sans serif font must be used for all body content. Serifs, the little tails on fonts like Times, can make 
letters harder to read for people with low vision or cognitive delays. The standard NHDES font is Calibri. 
Serif fonts can be used for headings or as accent fonts at a larger point size. Avoid using more than two 
fonts in any given publication. 

In situations where Calibri is not available, such as on websites or GIS, use rounder, wider fonts with 
consistent letter spacing – avoid using tall, thin fonts. Tall, thin fonts, such as Arial, do not have 
consistent letter spacing, which can cause readability issues for low-vision and neurodiverse individuals.  

Neurodiversity describes differences in learning, thinking and behavior. Examples of 
neurodiverse conditions include ADHD, autism, dyslexia, dyscalculia, Tourette’s, etc.  

Studies have shown that handwriting fonts can be easier for neurodiverse individuals. However, finding a 
handwriting font that also works well for people with low vision and looks professional can be a 
challenge. Therefore, it is best to stick with wider, more evenly spaced fonts. 

The standard font size is 11. It is also acceptable to use font size 12. The minimum font size is 9 but 
should be used sparingly and reserved for items such as captions. Headings should be 16-24 point. 

2.6.2 Justification 

Only use left justification. Full justification adds extra spaces between words and sentences that create 
“white rivers” across the page. This can be disorientating for low-vision or dyslexic readers.  

Right and center justification may be used sparingly to set a piece of text apart. 

2.6.3 Spacing 

Use one space between sentences. Extra spaces contribute to the “white river” effect. 

Use paragraph spacing to create space between paragraphs rather than clicking “enter” twice. A screen 
reader (the adaptive technology used by blind or dyslexic readers) will read the extra line as “break” or 
“new paragraph.” 

Avoid long blocks of unbroken paragraph text. Shorter paragraphs will help prevent all readers from 
losing their place or experiencing reading fatigue. 

Use Page or Section Breaks to move content to the next page or to change the formatting in the middle 
of a page (see Standard Styles – Tabs, Breaks and Columns). 

Use tab sets to create spaces within a line of text – do not click tab multiple times to create a large 
space, such as in a form. 

2.6.4 Heading Styles 

Each distinct section of a document, even a short one, should be set off with a heading. Always use 
Styles to create headings. Always use Heading 1 first – do not skip to Heading 3 just because the 
formatting looks better. You can easily customize Styles. Set your text the way you want it then right-
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click the Heading you want and select “Update Heading # to match selection.” You can also Modify 
heading styles beforehand. 

 

2.6.5 Footnotes and Endnotes 

Footnotes and endnotes must be added using the tools included in the software being used. 

2.6.6 Emphasis – underlines, bold, italics 

Use primarily bold for emphasis. Italics can be used but should be reserved for larger font sizes because 
it can look blurry for low-vision or dyslexic readers.  

Underlining is reserved for hyperlinks only.  

2.6.7 Underscores 

Underscores should never be used to create lines, such as in a form. Not only will your formatting break 
when someone types over the underscores but a screen reader will read every single one. Instead, use 
the line drawing tool that can be found on the Draw tab. Lines can be marked as decorative (see image 
descriptions). 

2.6.8 Text Boxes 

Avoid using text boxes to set text apart. Instead, use columns and “continuous” (same page) section 
breaks. Some adaptive technology cannot see text boxes so the information will be omitted. Others will 
add the text into the same layer as the body text and will create a disruption in the reading order.  

2.7 Web Addresses and Descriptive Links 
When embedding links, you must use descriptive text to indicate where the link is going. Even if the document 
will be printed, you still need to use descriptive links and not spelled out URLs. A screen reader will read a URL 
character by character. Screen readers can also “tab” though different resources in a document, such as links, 
so spelled out URLs are not helpful. In printed format, descriptive links provide search terms that are easier to 
consume and remember. It is very easy to make a mistake when typing out a long URL, which will only 
frustrate your readers. 

Correct:  
For the latest news on national environmental cleanup efforts, visit the EPA website.”  

Incorrect: 
“Click here to visit the EPA website for the latest news on environmental cleanup efforts.” 

NOTE: it is ok to spell out domain names but do not include the http part. Example: des.nh.gov  

https://www.epa.gov/
https://www.epa.gov/
https://www.des.nh.gov/
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2.8 Sensory: Color, Shape, Size, Visual Location or Sound 
Instructions provided for understanding and operating content cannot rely solely on sensory characteristics of 
components such as color, shape, size, visual location, orientation or sound. 

Care must be taken when using colors with text. People with colorblindness or low vision may have trouble 
distinguishing between colors of similar hue and tone. The standard NHDES colors are blue and green (see 
Logo Use Policy for specific color codes). Other colors can be used but should be used sparingly and as accents 
only. You cannot use text color alone to create emphasis – it must also be bold and/or italicized.  

Color contrast levels in text must meet WCAG AA standards.  

Resource: the WebAIM Color Contrast Checker provides contrast ratios and Pass/Fail indicators for WCAG AA 
and AAA standards. 

• Avoid using more than 3-4 colors – use a color palette that is coordinated and cohesive. More colors 
can be used in charts, if necessary. 

• DO NOT use color gradients in or behind text. 
• DO NOT use color alone to add emphasis to text – always use it with bold and/or italics. 

Consideration: someone with complete colorblindness will see red text as grey, so your red text will 
have less emphasis rather than more. 

• Avoid using non-standard colors for links – the standard is bright blue and underlined. 
• Avoid using drop shadows on text – they can make the text appear blurry.  

Drop shadows on images are acceptable. 
• DO NOT use background colors, textures or images in emails – these make text difficult to read. 

2.8.1 Colors and Graphics for Neurodiversity 

Avoid using extreme contrast (total white and total black). While high contrast is imperative, using dark 
grey text (such as used in this document) rather than black can help neurodiverse readers while 
maintaining high contrast levels. 

Color bars, images or small, single-color graphics at text sections can help neurodiverse readers form 
associations with the text and will also act as a visual cue for place-finding. 

2.9 Form Field Help Text 
All fillable form fields created using a form creator such as Word, Acrobat PRO, nForm, etc. must have help 
text. Help text should describe the purpose of the field, rather than instructions for what to put in it. For 
example, help text for a single-select field would instruct people to “make a selection.”  

Help text for a text field should not include an example that should be visible to all users but can include 
character limits. 

2.10 Data Tables 
Data tables must have a descriptive table heading row and CANNOT have split or merged cells. The table title 
should be added using a caption or figure Style. The table title should be added above the table. 

Data tables cannot have empty or null cells. This is because different screen readers will treat an empty cell 
differently – some may voice “blank” when they encounter an empty cell, others will not voice anything, which 
may make the user lose their place in the table.  

The best option is to use “No Value” for a blank cell. Avoid using N/A, as some screen readers will either voice 
nothing or voice, “nah.” 

https://webaim.org/resources/contrastchecker/
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2.11 Layout Tables 
Layout tables might be used for creating a form or other visual that does not contain data. The information in 
layout tables is not associated with a specific heading. Therefore, layout tables can have split and merged 
cells. However, it is important to check the “tab order” – the order of cells when clicking the Tab key – to make 
sure that it matches the intended visual order.  

It is also important to make sure that ALL fillable fields in a form are activated when using the Tab key. 

2.12 Readability – Plain Writing Act 

2.12.1 Background 

The Plain Writing Act states that public documents must use “clear government communication that the 
public can understand and use.” It is important to know your audience. Federal guidelines are available 
for tips on how to write to your intended audience. More information about readability can be found on 
the Readability Guidelines website. 

2.12.2 Know Your Audience 

If you are writing specifically for a graduate-level audience, it is not necessary to alter the reading level 
of your document. However, many NHDES documents are intended for the public in general. When text 
for these documents requires a reading ability higher than eighth grade, a version that does not require 
a higher reading level must be provided. This can be in the form of a brief Executive Summary. In Office 
products, the readability score is found at the very end of the Accessibility Check. 

Alternatively, you can check small portions of text at a time using this Reading and Grade Level 
Calculator. 

At the very bottom of a Word document, click “Accessibility: Investigate.” 

  

Under File > Options, click Proofing and then check the box for “Check Readability Statistics” then 
“Recheck Document” 

 

You may need to clear all the Accessibility Errors prior to getting the readability statistics. 

https://www.plainlanguage.gov/law/
https://www.plainlanguage.gov/guidelines/
https://readabilityguidelines.co.uk/
https://charactercalculator.com/flesch-reading-ease/
https://charactercalculator.com/flesch-reading-ease/
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2.12.3 Sentence Length 

Sentences should be an average of 15 words with a maximum of 25 words. 

2.12.4  Acronyms 

Acronyms must be defined and should be kept to a minimum. A glossary of acronyms is recommended if 
there are many in use. 

2.12.5  Scientific Terms 

Where possible, scientific terms should be defined. If they cannot easily be defined in the main report, 
they must be defined in an executive summary. 
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3 Nondiscrimination in Publications 
Please see the NHDES Nondiscrimination and Environmental Justice intranet page for more information, such 
as requesting language translation services. 

3.1 Language Services 
It is important to make sure that all critical publications are translated into any languages that are appropriate 
for the target audience. Read more on the Communication Access Services intranet page. 

Critical publications include permit applications and anything that concern public health, such as consumption 
or beach advisories, boil orders, notices of emergent contaminants, etc. 

3.2 Gender Neutrality 
Nondiscrimination in NHDES documents includes using gender-neutral language. Here is a list of commonly 
used words in NHDES documents and possible replacements. Please try to be aware of gender-specific 
language and replace it. MS Office products can identify gender-specific words and suggest alternatives. 

• Manmade – Synthetic 
• Fisherman – Angler, Fisher, Fisherperson 
• Selectman – Selectperson, Selectboard Member 
• Manhole – Maintenance Hole, Utility Access Hole 

 

3.3 Gender Identity 
It is not necessary to use “he or she,” “him or her” or “his or hers” when referring to a person. “They” and 
“theirs” are now considered both plural and singular pronouns. 

Use first and last name rather than Mr., Mrs. or Ms. when composing correspondence.  

  



Public Information Guidelines 26 October 21, 2022 

4 Forms 

4.1 Definition 
NHDES defines “Form” as a paper or automated means of capturing data or information from outside of 
NHDES, the purpose of which is to convey the data or information to NHDES. It also defines “Automated 
Submittal” (also known as “online submission”) as a Form that collects information online and uses a “submit” 
button to send data to NHDES.  

NOTE: This section of the Publication Information Guide was taken directly from, and now replaces, the NHDES 
SOP for External Form Development and Updating. It must be followed in the same manner. 

4.2 Electronic “Paper” vs. Online Submission 
New Hampshire Executive Order 2014-4 states that all business-related forms must be transitioned to online 
submission. Additionally, there is a current push from the Governor’s office to improve Digital Government. To 
that end, it is important to evaluate each form for transition to online submission. 

When updating a “paper” form (Word/PDF/Excel fillable or print-only), every effort must be made to transition 
to online submission. Currently, NHDES uses the New Hampshire Online Forms System, also known as nForm. 
This system is CROMERR (EPA’s cross-media electronic reporting rule) compliant, can collect payment, connect 
to backend databases for a push or pull of information, populate documents with user-submitted content, 
print blank forms, etc. 

Considerations for paper forms: 

• Locked, fillable Word forms are not accessible to screen readers. Word fillable forms must be 
unlocked. 

• Excel forms most often have split and merged cells, which makes them inaccessible. The “tab order” 
must be set to ensure a form can be completed using a keyboard. 

• PDF fillable forms need to be created using Acrobat Pro 12 or newer. Prior versions have a “view” 
restriction and cannot be used to create fillable forms. DO NOT use Cute PDFPro to create fillable PDF 
forms. The forms it produces do not look professional. 

4.3 Review Requirements 
All forms must be reviewed by your Bureau/Program – this is to include a review to ensure the form is 
authorized by rule(s) and/or law(s). You should also review the Permit Guides section of this document to 
determine, a) if your form requires a permit guide page, b) if you need to update an existing permit guide 
page. 

4.3.1 Review Frequency 

Each Bureau or Program is expected to review each form in the inventory and associated statute and/or 
rule at least once every year. Forms must be updated at least once every two years, and within one 
month following a rule change that impacts the associated form. Divisions may require more frequent 
form and statute/rule reviews. 

4.3.2 Content Review 

Each Bureau and/or Division will determine its own process to ensure sufficient review and approval of 
each form, including determining: 

• That the information requested is necessary for NHDES to meet its responsibilities.  

https://sos.nh.gov/media/drahbqtu/hassan-2014-4.pdf
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• That NHDES has the necessary statutory or rulemaking authority to request the information 
specified in each field, or that NHDES is requesting that information be provided voluntarily.  

• For voluntary information, that the statute and/or rule supporting the program, or other 
provisions of law, do not preclude requesting the information. 

• If the form is collecting any “confidential” or “personal information” requiring additional 
special handing. 

4.3.3 Confidential and Personal Information 

Each Bureau or Program should be particularly diligent in confirming the need to collect “confidential” or 
“personal information” and that they are properly authorized, via statute and/or rule, to collect such 
information. “Confidential” and “personal information” often require additional special handling and/or 
disclosure requirements if there is a security breach (see, for example, requirements of notice of a 
security breach and definition of “personal information” under NH RSA 359-C:19-20, and data access 
restrictions under Federal Taxpayer Information and Health Information Portability and Accountability 
Act (HIPAA)).   

“Personal information” generally includes:   

• Social security number. 
• Driver’s license number or other government identification number (e.g., tax payer ID 

number, passport number). 
• Account number, credit or debit card number, by itself or in combination with any required 

security code, access code, or password that would permit access to an individual’s financial 
account. 

• Copies of or information from any federal tax form, including tax returns, attachments or 
other forms used for transmitting tax-related information (e.g., 1099 or W-2). 

• Individually identifiable health or health insurance information. 

4.4 Formatting Online Form System Landing Pages 
A “Form Designer” is required to be able to create or edit a form in the Online Forms System (nForm). Form 
landing pages are seen before people can click “submit online” or “download mail-in form” to access the form. 
The following information must be included. A NHDES nForm Form Designer user group is available in Teams. 
Additional information can be found under nForm Governance. 

4.4.1 Overview Tab 

• Tag: the tag is the form number. 
• Keywords: use the same ones supplied for the form inventory. 

4.4.2 Details Tab 

• Form Name. 
• Reference Number: this is also the form number. 
• Short Description: what is this form used for? This appears below the form name on the 

Organization page. 
• General Instructions: this space is for form instructions and Permit Guide information. It 

also must contain the following, as the first three lines (use Shift-Enter for line breaks 
instead of paragraph breaks): 

o Form Number 
o Date (date of last revision or OLS approval) 
o RSA/Rule 
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4.4.3 Contacts Tab 

• Contacts: the address to which you want forms mailed and at least one Other Contact 
Method. 
The Concord address is: 
New Hampshire Department of Environmental Services 
[Bureau or Program Name optional] 
29 Hazen Drive, PO Box 95 
Concord, NH 03302-0095 

4.5 Formatting “Paper” Forms 
Paper forms are Word-, PDF- or Excel-based forms. They may allow for filling in fields but still are required to 
either be emailed or printed and mailed back to NHDES. 

All paper forms must have the following branding elements in the specified locations. 

• Form number in top-left corner (assigned by PIC). 
• NHDES logo and New Hampshire State seal at top of page. 
• Reference to RSA/Rules governing form at top-left of page. 
• Title. 
• Subtitle. 
• Division or Bureau/Program name. 
• Contact info: email address and/or phone number.  
• PO Box address. 
• NHDES website address: www.des.nh.gov. 
• Date of form approval by PIC in bottom-left corner in YYYY-MM-DD format. 
• Pagination in bottom-right corner in “Page X of Y” format (if longer than one page). 

Basic form example templates can be found on the S-drive. 

The following is more information on each element identified above and the recommended/required location 
and font size for each item. Paper forms must use Calibri for the font. 

4.5.1 Form Number 

The form number must appear in the top-left corner of the form in the following format:  

NHDES-X-##-###. Recommended font size: 10. This number will be assigned by PIC. 

4.5.2 Logo and State Seal  

The NHDES logo should appear in the upper-left corner of the page with the State seal across from it in 
the upper-right corner. The logo and seal should be of approximately the same size. NOTE: The State 
seal may be removed/replaced with another logo on course enrollment forms (see template folder for 
example course enrollment form). DO NOT place the form header in a text box. Please review Chapter 
2.4.10 – Text Boxes for information about ADA compliance. 

4.5.3 Title 

Form titles should include a topic that is understandable to your customers and searchable online, i.e., 
“Large Groundwater Withdrawal.” It must be centered between the logo and seal. Recommended font 
size: 16. 

file://granite.nhroot.int/shared/des/DES-RESTRICTED/FormInventory/Update/templates
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4.5.4 Subtitle 

The subtitle should be one of the following authorization types: Permit, Approval, Certification, License, 
Registration, or Notification. It must be immediately below the Title. Recommended font size: 16. 

4.5.5 Division and/or Bureau/Program Name 

Your Division and/or Bureau/Program name should go immediately below the subtitle and can use up to 
two lines. Recommended font size: 14. 

4.5.6 Reference to RSA/Rule/Voluntary 

Reference to the RSA/Rule governing your form should be bold and left-justified above the form 
content.  

Recommended font size: 11. Example: RSA 485:3, XI; Env-Dw 303. 

4.5.7 Contact Information - Footer 

Basic contact information must be provided on your form including: a common phone number (use your 
program phone number or the general NHDES number of (603) 271-3503); PO Box address; and NHDES 
website. You may also include a common email address if your program has one. 

The contact information is suggested to be included as a footer for your form. Alternatively, this contact 
information can be provided in some other location on your form (e.g., sidebar or banner) or as a part of 
the form content. If in footer, recommended font size: 10, if in Form Content, recommended font size: 
11. 

Additional, more specific contact information, such a specific individual’s name, email and telephone 
number, can be included as part of your Form Content.  

Example common footer: 
program@des.nh.gov or phone (603) 271-3503 

PO Box 95, Concord, NH 03302-0095 
des.nh.gov 

If space becomes an issue, it is acceptable to include the footer only on the odd pages of a multi-page 
form. 

4.5.8 Date 

A date must be included for version control. If the form update contains only “editorial” information, 
such as fixing a typo or moving a form field from one section to another, the date does not need to be 
updated. Please include this information in you update request. The date on the form must match the 
date added/modified on the Master External Form Inventory spreadsheet – this date may be updated by 
PIC to coincide with when the form is made available to the public. The Inventory may not need to be 
updated for editorial changes; the Inventory MUST be updated if there is a contact change.  

Date format should be: YYYY-MM-DD. This must be in the very bottom-left corner.  

Recommended font size: 10. NOTE: if your form must be approved by OLS, the date on the paper form 
and nForm landing page needs to be the approved date. 

4.5.9 Pagination 

Pagination must be provided for forms longer than a single page. Use “Page X of Y” formatting. This must 
be in the very bottom-right corner. Recommended font size: 10. 

mailto:program@des.nh.gov
tel:+16032713503
http://www.des.nh.gov/
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4.6 Permit Guides 
Any NHDES form that provides “authorization” (permit, approval, license, certification, registration, 
notification, etc.) requires a permit guide page. Permits are listed on the NHDES Permit Guidance page. You 
must include a brief description of each of the following categories (indicate “none” if the category does not 
apply). 

Formal Name of Authorization  
The general term “Authorization” is being used here to denote a permit, approval, license, certification, 
registration, notification, etc. Please use the selected type of authorization consistently when completing this 
permit guide and when communicating with an applicant. 

Examples Authorizations: 
Aboveground Petroleum Storage Tank Facility Registration 
Alteration of Terrain Permit 
Air Annual Compliance Certification 

Introduction (optional) 
Be as concise as possible with no more than three or four sentences and a 150-word limit.  

Purpose (this may be able to fit in the Short Description field in nForm) 
Describe the purpose of the authorization (why is this authorization needed/what does the authorization allow 
the holder to do, how is it applied to protect the environment or public health?). Be as concise as possible with 
no more than two or three sentences. 

Applicability 
Describe the applicability of the authorization (who is required to obtain the authorization? when must it be 
obtained?) as concisely as possible, in no more than two or three sentences. 

Statute and Administrative Rules  
Provide links to the enabling statute and administrative rules. You must link to a webpage, not a PDF of the 
rules. 

Fee 
Provide information as concisely as possible regarding whether there is an application fee and, if there is, 
determine the amount of the fee and when the fee must be paid. Provide a link to additional fee information, 
if any is available online. If there is no fee for the authorization, please indicate “No fee” or “None.”  

Processing Time 
For programs having statutory time limits for processing applications, provide that information. For programs 
not having such statutory limits, provide an estimate of time (or typical range in days, weeks, or months) 
required to (1) determine whether an application is administratively “complete” and ready for a technical 
evaluation, and (2) the time required to process the application and render a decision. 

Term/Renewal 
State the length of time the authorization is valid and whether the authorization may be renewed. If the 
authorization is renewable, briefly identify (or provide a citation to) the renewal procedures and a link to any 
additional renewal information that is available online. Include information here on renewal fees, when the 
renewal must be requested, and any limitations on renewals (such as the number of times an authorization 
can be renewed and the renewal period). 

  

https://onlineforms.nh.gov/Home/a6d08726-405c-40b8-8a59-fef1bbf0336c
https://onlineforms.nh.gov/app/#/formversion/6e39cf88-2c40-4289-881f-df18ef380f0f
https://onlineforms.nh.gov/app/#/formversion/e97ee242-4c38-43fc-bafc-6505781416b3
https://onlineforms.nh.gov/app/#/formversion/471c94f2-1853-4766-a8ae-cd941ddd1480
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Modification/Amendments 
Indicate whether the authorization may be modified or amended. If the authorization can be modified, briefly 
identify (or provide a citation to) the applicable procedures and a link to any additional relevant information 
that is available online. Include information here on any fees that apply to modifications, when the 
modifications must be requested, and any limitations on modification (such as what changes can be handled as 
a modification and what changes require a new authorization). 

Transferability 
Indicate whether the authorization may be transferred. If the authorization can be transferred, briefly identify 
(or provide a citation to) the applicable procedures and a link to any additional relevant information that is 
available online. Include information here on any fees that apply to transfers, when the transfer must be 
requested, and any limitations on transfers (such as when/to whom a transfer can be made). 

Appeals 
Identify the Council to which appeals of authorization decisions must be made and when the appeal must be 
filed. If the person wishing to appeal is required by statute to request reconsideration prior to filing an appeal, 
include information on how and when to request reconsideration. Include links to the Council’s rules and to 
the fact sheet on appealing NHDES decisions. If applicable, identify the statute and rules that apply to the 
reconsideration process. 

Status of Current Applications 
Briefly describe how the public can check the status of a pending application (for example, through OneStop or 
the program’s homepage, direct calls to the program staff, etc.). Include an online method if available. 

More Information 
Indicate how to obtain more general or specific information regarding this authorization. Include a link to the 
program’s homepage and a link to any non-NHDES resources that you feel will assist the applicant in filing a 
complete application (will save NHDES time in the long run). 
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